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About InSIDE 

The aim of the project is to develop accessible DE programmes for individuals with ViHeMo 

impairments. The concrete aims are to: a) develop an accessible, inclusive and educationally effective 

model of DE that will deliver key competences for vocational rehabilitation, and provide 

opportunities for lifelong learning, skills enhancement, and personal fulfilment with the ultimate aim 

of suggesting an intelligent solution against the problems of limited access or high percentage of 

dropouts in HE in IwI, b) structure a strong cooperation between organisations with sound expertise 

in accessible and inclusive HE and organisations where both the modernisation of HE and the 

promotion of the right to education of IwI is imperative, and c) widen the horizons of local HE 

towards an international and intercultural education through DE programmes. 

The overall objectives of the project are to: 

1) Develop new and innovative, accessible and inclusive DE programmes improving the quality 

of HE for individuals with ViHeMo impairments and offering flexible learning and virtual 

mobility 

2) Upgrade the facilities through establishing accessibility offices and acquiring assistive 

technology resulting in modernization of university services 

3) Build capacity and professional development in administrative and teaching staff in 

developing and carrying out accessible and inclusive DE programmes, and operating the 

accessibility offices 

4) Involve individuals with ViHeMo impairments in a user-center design so that accessibility and 

usability are achieved in conjunction, and the links between education and society are 

strengthened 

The specific objectives of the project are: 

• The preparation of the development stage through an extended literature review for 

precedent trials in DE for IwI 

• The development of the most suitable educational material for IwI (ViHeMo) in terms of 

accessibility, usability and educational efficacy through the study of end-user 

requirements 

• The adaptation of a course delivery system that best serves the needs of IwI (ViHeMo) in 

DE 

• The foundation of accessibility services in HE so that SwI would be supported during their 

attendance in HE 

• The training of advisors in the services of the accessibility offices, and the training of the 

trainers (advisors and representatives) so that they will be able to train the end-users 

(teaching staff and IwI) 

• The examination of the regular co-operation of all the above to deliver inclusive DE 

courses effectively when learning and skill enhancement are concerned, considering end-

users feedback too 
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• The dissemination and exploitation of the project deliverables on an international level. 

Executive summary 

The Guide on educational material in fully accessible form is the result of core activities that were 

realized in the context of InSIDE project. Specifically, in WP2 the adapted educational material was 

initially designed, developed in a preliminary version, assessed in two ways – through pilot testing 

and through examining the end-users’ requirements – and then developed in its final version. The 

present guide constitutes the manual in which anyone who wishes to develop adapted educational 

material for individuals with visual, hearing or mobility impairments could find the necessary 

guidelines per kind of material, i.e. accessible e-books (MS-Word, ePub and DAISY), accessible 

presentation using Power Point, accessible PDF files, videos, mathematical and chemical equations, 

verbal descriptions of pictures, tactile pictures, and audio-tactile pictures.  In addition, the guide 

could be used to explore the adapted educational material per impairment: blindness, residual 

vision, mobility impairments and hearing impairments.  

Important note: It is strongly recommended to use the present guide in combination with the 

deliverable 2.3 Final adaptations on the educational material where additional suggestions by the 

end-users themselves have been included. In this way, whoever wishes to find and develop a more 

tailor-made solution of accessible educational material should fulfill his/her needs. 
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1. Guidelines for developing accessible texts/e-books 

1.1. MS-WORD 

1.1.1. Specify Document Language 

 Screen readers can read text in many languages but they do not automatically specify the 

language of your document. 

 If your document has text written in more than one language, you must make certain 

that every section of your text that appears in a different language is properly identified. 

To Specify Document Language: 

1. Select the text written in a different language. 

2. Go to the Review tab in the ribbon. 

3. In the language section, select Language. 

4. Select Set Proofing Language. 

5. Choose the appropriate language from the list. 

6. Select the OK button. 

 

Figure 1:The initial four steps (Steps 1 to 4) for specifying the document language. 
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Figure 2: Steps 5 and 6 for specifying the document language. 

1.1.2. Add headings 

 Headings are one of the main ways that screen reader users navigate through the 

document. 

 Use a separate style for each heading level. For example, heading 1 is the highest or 

main level of heading, heading 2 is a subheading of Heading 1, heading 3 is a 

subheading of heading 2, and so on through heading 4 and 5. 

To add headings 

1. Select the text you want to turn into a heading.  

2. Go to the Home tab in the ribbon. 

3. In the Styles group, select the heading level that you wish to apply. 

4. Press Enter on your keyboard to move your cursor to the next line. The heading formatting 

will automatically turn off. 
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Figure 3: Steps 2 and 3 for including headings. 

1.1.3. Create lists 

 Utilize Word's formatting tools instead of manually typing numbers or dashes to 

indicate list items. 

To create an ordered or unordered list 

1. Go to the Home tab in the ribbon. 

2. In the Paragraph section, select the Bullets icon for unordered lists or select the Numbering 

icon for ordered lists. 

That will start your list. Each time you press Enter you’ll start a new list item. 

 

Figure 4: Steps 1 and 2 for creating lists 

1.1.4. Use meaninigful link text 

 Hyperlinks are more effective navigation aids when users understand the purpose of 

the link. 
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 Ensure that all links have text that describe the purpose of the link. 

Tips 

 Links should make sense out of context. 

 Links do not need to include “link” in the link text. 

 Don’t duplicate link text. 

 Avoid link text that’s longer than a sentence. 

 Avoid phrases like “read more” or “click here”. 

 If you want to link to something that isn’t a website – such as a PDF file – you should 

refer this information in the link text. 

To add hyperlinks with meaningful text 

1. Copy the hyperlink that you would like to replace with meaningful text. 

2. In Word, place your cursor where you want the hyperlink to appear. 

3. Go to the Insert tab. In the Links group, select Links or Right-click and Select Link. 

4. Enter the descriptive link text in Text to Display. 

5. Enter the URL in the Address. 

6. Select Ok. 

 

Figure 5: Step 3 for adding hyperlinks with meaningful text. 

 

Figure 6: Step 4 for adding hyperlinks with meaningful text. 
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Figure 7: Steps 5 and 6 for adding hyperlinks with meaningful text. 

1.1.5. Create Accessible Tables 

 Screen readers read tables horizontally—cell by cell, row by row. 

 Row and column headers help give context to the data in each cell for people with visual 

impairment. 

Tips 

 Tables should be used only for data or information that requires organization with rows and 

columns, not for layout or lists. 

 Keep tables simple by avoiding merged cells and splitting complex tables into separate 

smaller tables. 

 Write “left blank” or “blank” in tables with missing data. 

 Use “real tables” rather than text formatted to look like tables using the TAB key or space 

bar. It could be difficult or impossible to understand for people using screen readers.  

 If tables split across pages, set the header to show at the top of each page.  

 Define the start and end of the figure. For example, 

Table start 

Insert table 

Table end 

To add table 

1. Go to the Insert tab in the ribbon 

2. In the Tables section, choose Insert Table. (Do NOT use the Draw Table feature because this 

feature will not create an accessible table.) 
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3. Choose the Number of columns and the Number of rows you would like your table to have. 

4. Select the OK button. 

 

Figure 8: Steps 1 and 2 for creating accessible tables. 

 

Figure 9: Steps 3 and 4 for creating accessible tables 

To make the first row a header row 

1. Select the first row of your table that you would like to make into the heading row. 

2. Right-click the row and select Table Properties. 

3. Select the Row tab. 

4. Uncheck Allow row to break across pages. 

5. Check Repeat as header row at the top of each page. 

6. Select OK. 
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Figure 10: Steps 1 and 2 for making the first row as a header row 

 

Figure 11: Steps 3 to 6 for making the first row as a header row. 

To add alternative text to a table 

(Alternative text, or “alt text” describes the content of a table, if needed) 

1. Right-click the table 

2. Choose Table Properties. 

3. Select the Alt Text tab 

4. In the Description area, write a summary of your table’s content or structure. 

5. Select the OK button. 
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Figure 12: Steps 1 and 2 for adding alternative text to a table. 

 

Figure 13: Steps 3 to 5 for adding alternative text to a table. 

1.1.6. Provide Alternative Texts for Images and other Objects 

 What are images? Images are non-text elements that include photographs, illustrations, 

diagrams, pictures, charts, graphs, and maps. 

 Alternative text, or “alt text” describes the content of images. 

Tips 

 Try to describe the image without making too many of your own assumptions. 

 Imagine you are describing the image to a person over the phone. 
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 Do not include phrases like "image of ..." or "graphic of ...", etc. If the fact that an image is a 

photograph or illustration, etc. is important content, it may be useful to include this in 

alternative text. 

 If the object is an image of text, then the alt text must match the text verbatim. 

 When an image is too intricate to adequately describe using only alternative text (e.g., 

artwork, flowcharts, etc.), ensure to provide both a brief text alternative and a more 

detailed description. 

 Long descriptions/verbal descriptions should be used when alternative texts are inadequate 

in addressing the question: “What information is the image conveying? 

 If the image is decorative, check Mark as decorative or type decorative image. 

 Do not select the “Generate a description for me” button. 

 Define the start and end of the figure. For example, 

Figure start 

Insert image 

Verbal description: …. 

Figure end 
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Figure 14: An example image illustrating the beginning and the end poimts of the figure. 

To add alternative text to images/graphical objects 

1. Insert the image/object you want to use into the document. 

2. Right-click the image/object. 

3. Select Edit Alt text. 

4. The Alt Text pane opens on the right side of the document body. Fill in the field. 

 

Figure 15: Step 3 for adding alternative text to images 
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Figure 16: Step 4 for adding alternative text to images. 

1.1.7. Avoid “Floating” Elements 

 When specific elements (such as images or objects) are inserted into Word 

documents, they are initially set as "inline objects." Inline objects maintain their 

position on the page relative to the text. 

 However, Word also offers the option to have these elements "float" outside of the 

text order, allowing text to flow around, under, or over them. 

To prevent an image or object from “floating” 

1. Select the image/object. 

2. Go to Layout tab in the ribbon. 

3. Select Position from the Arrange section. 

4. Select in Line with Text. 
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Figure 17: Steps 1 to 4 for preventing an image or object from “floating“ 

1.1.8. Check Accessibility 

 If you wish to check the accessibility of your document, Word offers an “Accessibility 

Checker”. 

 Please note that no checker can identify every type of accessibility issue comprehensively. 

The “Accessibility Checker” classifies issues as 

 Error. 

 Warning. 

 Tip. 

To use the “Accessibility Checker” 

1. Make sure the file is saved as a DOCX. (Note: Older DOC files are not compatible with the 

checker). 

2. Go to File tab in the ribbon.     

3. Select Info in the left window pane. 

4. Select the Check for Issues dropdown. 

5. Select the Check Accessibility item. An Accessibility Checker task pane will open, showing the 

inspection results. 
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6. Select a specific issue to see Additional Information.  

7. Follow the steps provided to fix or revise the content. 

 

Figure 18: Step 2 for using the Accessibility Checker 

 

Figure 19: Steps 3 to 5 for using the Accessibility Checker 

1.1.9. Use Built-In Document Structuring Features 

Table of contents 

 It gives users an overview of the document's organization and contents. 

 The best way to generate a table of contents is after applying the predefined heading 

styles (e.g., “Heading 1,” “Heading 2,” “Heading 3”). 

To insert a table of contents 

1. Place the cursor in your document where you want to create the table of contents. 

2. Go to the References tab in the ribbon. 

3. In the Table of Contents section, select Table of Contents. 

4. Select the style that you want to use. 
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Figure 20: Steps 2 to 4 for inserting a table of contents. 

To update a table of contents 

1. Select the table of contents. 

2. Go to the Reference tab in the ribbon. 

3. In the Table of Contents section, choose the Update Table button. 

 

Figure 21: Steps 1 and 2 for updating a table of contents. 

Page numbering 

 Numbering the pages of you document helps readers in efficiently navigating and 

referencing its content. 

 Select the top left option as the page number location. 
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To insert page numbers 

1. Go to menu item: Insert.  

2. In the Header & Footer section, select Page Number. 

3. Select Top of page. 

4. Select top left page numbering. 

 

Figure 22: Step 1 for inserting page numbers 

 

Figure 23: Steps 2 to 5 for inserting page numbers. 

Page break 

 To begin a new page with consistent page layout (including page orientation, headers, page 

numbering, etc.), use a page break instead of using multiple hard returns 

consecutively. 

To add a page break 

1. Go to the Insert tab in the ribbon.  

2. In the Pages section, select Page Break. 
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Figure: 24. Steps 1 and 2 for adding a page break. 

1.1.10. Use bookmarks & cross-references to link to other parts of a document 

 In Word, a bookmark functions similarly to a physical bookmark in a book, allowing you to 

mark a specific location for easy retrieval. 

 For lengthy documents, you can improve organization and navigation by inserting bookmarks 

within rich content fields and creating cross-references to those bookmarks. 

 A cross-reference serves as a hyperlink to a bookmark within a document and is stored as a 

URL in the rich content field of an item. It appears as a blue, underlined hyperlink 

within the rich content field and can be accessed exclusively in the Document view. 

To add bookmarks 

1. Select the text or a place in your document where you want to insert a bookmark. 

2. Go to the Insert tab in the ribbon. 

3. In the Links section, choose Bookmark. 

4. Under Bookmark name, type in a name. (Names must not contain spaces.) 

5. Select Add.  

The bookmark is created. 

 

Figure 25: Step 1 for adding bookmarks. 
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Figure 26: Steps 2 and 3 for adding bookmarks. 

 

Figure 27: Step 4 for adding bookmarks. 

Link to a bookmark 

1. Select the text or object you want to use as a hyperlink. 

2. Right-click and select link. 

3. In the Insert Hyperlink dialog box, under link to, click Place in this Document. 

4. In the list, choose the bookmark that you want to link to. 

5. Select the ok button. 
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Figure 28: Step 1 for linking to a bookmark. 

 

Figure 29: Step 2 for linking to a bookmark. 

 

Figure 30: Steps 3 to 5 for linking to a bookmark. 
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Figure 31: An illustration of a reference linked to a bookmark. 

1.1.11. Make Content More Accessible 

Tips 

 Use font size 12 points for body text. 

 Use Sans serif fonts (e.g., Arial) which are typically easier to read than serif fonts (e.g. 

Times New Roman, Garamond). 

 Use high contrast colors for text and background. For example, black text on a white 

background or white text on a black. 

 Use bold fonts for emphasizing words and phrases instead of underlining. 

 Only use underlining as the standard option to emphasize links for websites and email 

addresses. 

 Left alignment is recommended for all the document. 

 Do not use enter, space or tab keys to add white space. 

 Use the Page Break tool to start a new page. Do not press Enter repeatedly to start a 

new page. 

 Ensure that color is not the only means of conveying information. 

 For headings, consider adding bold and using a larger font. 

1.2. DAISY 

 DAISY, an international standard for digital talking books (DTBs) and multimedia 

representation of print publication, facilitates easy navigation through structured text, 

such as by headings or pages. 

 A DAISY book can consist of text only, audio only, or a blend of audio and text. The 

audio component can be recorded speech or computer-generated speech. By 

synchronizing audio, images, and text, DAISY multimedia accommodates various 

learning styles and preferences. 

Converting a WORD file into a DAISY DTB using the Dolphin EasyConverter 

1. Start the conversion process by selecting "New Project." This action will direct you to the 

"Project Information" screen. 
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2. In the "Project Information" section, provide a name for your project. Utilize the "Browse" 

button to choose the desired saving location. Click "Next" once you're done. 

3. Select the "Open a file" radio button under "Choose your input document," then click 

"Browse." 

4. Proceed by selecting "Next." 

5. Under "Document settings," opt for "No" for "Use heading detection during conversion" as 

you will manually handle this later in the tutorial. If you wish to delegate this task to 

EasyConverter in the future, choose "Yes." 

6. In "Document settings," choose either "Yes" for "Edit the intermediate document in 

Microsoft Word during conversion" or "No." Click "Next" to proceed. 

7. For "Choose your alternative format," select "DTB" from the dropdown list of "New output 

type." From "DTB Type," choose "Daisy 2.02." 

8. In "Choose your alternative format," select the "Yes" audio button to generate a DTB with a 

built-in voice. Alternatively, select "No." Choose your preferred voice and lexicon from 

the respective dropdown menus. 

9. Navigate to "Choose settings > Page numbers > Word page numbers." Select the OK button, 

then click "Next" to continue. 

10. Determine your desired output name for the DTB. Provide a name and consider adding extra 

information, such as the format type (DTB), creation date, built-in voice name, and 

lexicon name. To exclude this additional information, uncheck the "Append selected 

item to the output name" box. 

11. Save your alternative format. By default, the project will be saved to the designated location. 

If you wish to create an additional copy in another location, CD/DVD, or USB device, 

select the appropriate option from the "Copy it to" dropdown list. Alternatively, 

choose "No copy to" to skip saving an extra copy. 

12. Initiate the conversion process by selecting "Finish." 

13. To view the DTB, choose "View Output" or open the file from its saved location. 
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Figure 32: Step1 for converting a WORD file into a DAISY DTB using the Doplhin EasyConverter. 

 

Figure 33: Step2 for converting a WORD file into a DAISY DTB using the Doplhin EasyConverter. 
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Figure 34: Steps 3 and 4 for converting a WORD file into a DAISY DTB using the Doplhin EasyConverter. 

 

Figure 35: Steps 5 and 6 for converting a WORD file into a DAISY DTB using the Doplhin EasyConverter 
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Figure 36: Steps 7 to 9 for converting a WORD file into a DAISY DTB using the Doplhin EasyConverter. 

 

Figure 37: Step 9 for converting a WORD file into a DAISY DTB using the Doplhin EasyConverter. 

 

Figure 38: Step10 for converting a WORD file into a DAISY DTB using the Doplhin EasyConverter 
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Figure 39: Step11 for converting a WORD file into a DAISY DTB using the Doplhin EasyConverter. 

1.3. EPUB 

WordToEPUB 

 Using WordToEPUB you can convert documents from your word processor to the latest EPUB 

3 format. 

  The EPUB files created with this tool can be used in a wide variety of reading apps on any 

platform, with the ability to personalize visual features such as colors, font, text size, 

and layout. 

 WordToEPUB is free to download and use 

(https://daisy.org/activities/software/wordtoepub/). The app works on Windows 7, 8, 

10, and 11.  

 

Figure 40: The WordtoEPUB plugin in the Word ribbon after it has been downloaded. 

To convert an accessible Word file to an EPUB file using the WordToEPUB plug-in: 

1. Open your Word document that you want to convert to EPUB. 
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2. Ensure that your Word document is accessible, meaning it adheres to accessibility 

guidelines for structure, formatting, and alternative text for images. 

3. Install the WordToEPUB plug-in if you haven't already. You can find and download it 

from the official website (https://daisy.org/activities/software/wordtoepub/). 

4. Once installed, the WordToEPUB plug-in should appear as a new tab or option in your 

Word application. 

5. Click on the WordToEPUB button within the plug-in interface. 

6. A conversion settings or options window will appear. You can adjust various settings 

related to the EPUB file, such as metadata, formatting. 

7. Adjust the conversion settings according to your preferences, or you can simply use 

the default settings. 

8. After reviewing and configuring the desired options, initiate the conversion process by 

clicking on the "OK" button within the plug-in. 

9. The WordToEPUB plug-in will begin converting your accessible Word document to 

EPUB format. The duration of the conversion will vary based on the document's size 

and complexity. 

10. Once the conversion is finished, the plug-in will provide a notification or prompt 

indicating the successful conversion. 

11. Locate the newly generated EPUB file in the designated output folder or directory. 

12. You can now transfer or distribute the EPUB file for utilization on various e-reader 

devices or platforms that support EPUB format. 

2. PowerPoint 

2.1.1. Choose an accessible template 

Tips 

 Create a presentation with a simple and clean slide layout. 

 Avoid using colored or patterned backgrounds. 

 Microsoft has identified several Accessible PowerPoint templates 

To find an accessible template 

1. Select File tab in the ribbon. 

2. Select New. 

3. In the Search for Online templates and themes text field, type accessible templates 

https://daisy.org/activities/software/wordtoepub/
https://templates.office.com/en-us/accessible-powerpoint-template-sampler-tm16401472?ui=en-US&rs=en-US&ad=US


 

InSIDE project Page  WP2: Adapted Educational Material 

2018-3218 /001-001 [36|85] DEV2.4 Guide on educational material in fully accessible 
form 

 

4. Press Enter 

5. In the search results, select a suitable template. 

6. In the template preview window, select Create. 

 

Figure 41: Step 1 for finding an accessible template 

 

Figure 42: Steps 2 and 3 for finding an accessible template. 

 

Figure 43: Steps 4 and 5 for finding an accessible template. 
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Figure 44: Step 6 for finding an accessible template. 

2.1.2. Use Unique Slide Titles 

Tips 

 Use unique slide titles. 

 Avoid using the same title for slides that have spill-over information. 

 For example, “Slide Title 1 of 2”, ‘Slide Title 2 of 2”. 

2.1.3. Specify Language 

To set a different language 

1. Select the text written in a different language. 

2. Go to the Review tab in the ribbon. 

3. In the language section, select Language. 

4. Select Set Proofing Language. 

5. Choose the appropriate language from the list. 

6. Select the OK button. 



 

InSIDE project Page  WP2: Adapted Educational Material 

2018-3218 /001-001 [38|85] DEV2.4 Guide on educational material in fully accessible 
form 

 

 

Figure 45: Steps 1 to 6 for specifying language. 

2.1.4. Add meaningful link text 

Tips 

 Raw URLs may not make sense to screen reader users or others, so make the link descriptive. 

 Avoid phrases like “read more” or “click here”. 

 Links should make sense out of context. 

To add a hyperlink to a slideshow 

1. Copy the hyperlink that you would like to replace with meaningful text. 

2. Place your cursor where you want the hyperlink to appear. 

3. Go to the Insert tab. In the Links group, select Links or Right-click and Select Hyperlink. 

4. Enter the descriptive link text in Text to Display. 

5. Enter the URL in the Address. 

6. Select Ok. 
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Figure 46: Step 3 for adding meaningful link text. 

 

Figure 47: Step 4 for adding meaningful link text. 

 

Figure 48: Steps 5 and 6 for adding meaningful link text. 

2.1.5. Add Alt Text to all images/objects 

Tips 

 Alt text should convey the meaning of the image. 
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 Some versions of PowerPoint have a “Title” and “Description” field. If so, ignore the “Title” 

field and add alt text to the “Description” field. 

 If an image/object is decorative, it should be clearly labeled as decorative or type 

“decorative”. 

 If a complex image requires more than 1-3 sentences to describe, add a verbal description of 

image under the graphic. 

To add Alt Text 

1. Select the image/object 

2. Right-click on the image 

3. Select Edit Alt text or Select Format Picture 

4. If you selected Format Picture, then in the Format Picture sidebar, choose the Alt Text tab. 

Enter appropriate alt text in the Description field only. 

 

Figure 49: Steps 1 to 3 for adding alt text. 

2.1.6. Use a simple table structure and specify table headers 

Tips 

 Tables should be used only for data or information that requires organization with rows and 

columns, not for layout or lists. 
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 Keep tables simple by avoiding merged cells and splitting complex tables into separate 

smaller tables. 

 Write “left blank” or “blank” in tables with missing data. 

 Define the start and end of the table. For example, 

Table start 

Insert table 

Table end 

To add table 

1. Go to the Insert tab in the ribbon. 

2. In the Tables section, choose Insert Table. 

3. Choose the Number of columns and the Number of rows you would like your table to have. 

4. Select the OK button. 

Note: Avoid using the Draw Table feature as it does not generate an accessible table. 

 

Figure 50: Steps 1 to 4 for using a simple table structure. 

Extra Tips 

 Choose Table Design tab > Table styles > Borders > All borders. 
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 Choose Table Design tab > Table styles > Shading > No fill. 

 

Figure 51: Steps for choosing table design tab. 

To add table headers 

1. Position the cursor anywhere in the table. The Table Tools will appear. 

2. Select the Table Design tab. 

3. In the Table Style Options, choose the Header Row check box. 

4. In the table, type the column headings. 

 

Figure 52: Choosing the Header Row check box. 

To add alt text 
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(Alternative text, or “alt text” describes the content of a table, if needed) 

1. Right-click the table. 

2. Choose Edit Alt Text. 

 

Figure 53: Steps for adding alt text. 

 

Figure 54: Example of an accessible table. 

2.1.7. Set Reading Order of Slide Contents 

Introduction 

 Screen readers read the elements of a slide in the order they were added to the slide. 

 Check the reading order. 
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To check the reading order 

1. Go to the Home tab in the ribbon 

2. Go to the Drawing section. 

3. Select Arrange. 

4. Choose Selection Pane. The Selection Pane will appear in the right-hand sidebar. 

NOTE: The reading order in the Selection Pane should be arranged from the bottom up. The title 

should be at the very bottom with subsequent content following it. 

 

Figure 55: Steps 1 to 4 for checking the reading order. 

2.1.8. Use the Accessibility Checker 

To use the “Accessibility Checker” 

1st way 

1. Go to the Review tab in the ribbon. 

2. In the Accessibility section, choose Check Accessibility. 

3. Choose again Check Accessibility. 
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Figure 56: Steps for using the Accessibility Checker (1st way). 

To use the “Accessibility Checker” 

2nd way 

1. Go to the File tab in the ribbon. 

2. Select Info. 

3. Select the Check for issues button. 

4. In the Check for issues drop-down menu, choose Check Accessibility. 

 

Figure 57: Step 1 for using the „Accessibility Checker“. 

 

Figure 58: Steps 2 to 4 for using the „Accessibility Checker“. 
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2.1.9. Make PowerPoint more Accessible 

Tips 

 Use font size 12 points for body text. 

 Use Sans serif fonts (e.g., Arial) which are typically easier to read than serif fonts (e.g. Times 

New Roman, Garamond). 

 Use high contrast colors for text and background. For example, black text on a white 

background or white text on a black. 

 Use bold fonts for emphasizing words and phrases instead of underlining. 

 Left alignment is recommended for all the document. 

 Only use underlining as the standard option to emphasize links for websites and email 

addresses. 

 Use the list buttons to create lists. Don’t just use “-” to manually make a 'fake list’. 

3. PDF Documents 

By the term accessible pdf, we refer to the pdf (portable document format) files that are created in a 

way that can be used successfully by individuals with impairments. The accessible pdf files are 

compatible with various kinds of assistive technology e.g., screen readers, magnifiers, voice dictation 

software, Braille displays etc. 

Pdf files are created in 3 ways: 

1. They are created by converting a file from a word processing program (e.g., Microsoft 

Office, Libre Office, Google docs) into pdf. The accessibility of the pdf depends on the 

original file. Word processing programs have accessibility checking features that help 

the authors correct accessibility mistakes. In the case of Microsoft word, when 

exporting into pdf, the Document structure tags for accessibility checkbox, should be 

selected. 

2. They are extracted from a program/software and the accessibility depends on the 

program that creates it 

3. They are created by scanning or taking a picture of a document. These documents are 

not accessible and need processing.  



 

InSIDE project Page  WP2: Adapted Educational Material 

2018-3218 /001-001 [47|85] DEV2.4 Guide on educational material in fully accessible 
form 

 

There are PDF accessibility standards outlined in the Web Content Accessibility Guidelines. The key 

information/elements most accessible pdfs include are: 

 Document tittle 

 Alternative text description for graphics and other non-text elements 

 Correct navigational aids (heading, links, etc.) 

 Correct color contrast 

 No dependence on color when conveying information 

 Document language indication 

 Appropriate tags 

Pdf accessibility audits can be performed by using auditing tools. Either using the native adobe 

acrobat tool, or by using a commercial tool (e.g., PAC (pdf accessibility checker) 2021). 

The link PDF Techniques for WCAG 2.0. discusses the techniques proposed by WCAG for creating 

accessible PDFs. 

4. Video for Individuals with visual impairments 

To make a video accessible for people with visual impairments, there are three primary options for 

providing description of visual information: 

a. Integrated Description. In this option, the description is included within the main 

speakers' scripts. The video's dialogue incorporates descriptions of important visual 

elements, actions, and other relevant details. This integrated approach ensures that 

the audio description seamlessly blends with the main content, allowing individuals 

with visual impairments to follow along without the need for separate audio or video 

tracks. 

b. Alternative video. This option involves creating a separate video that includes the 

audio description. The main video remains unchanged, while the audio description is 

provided in a separate video track. Viewers have the option to access the alternative 

video, which presents the descriptions of visual elements alongside the original 

content. This option offers a clear separation between the main video and the audio 

description, allowing users to choose which version to watch. 

c. Transcripts. This option involves a text-based document that provides a written 

version of the spoken content and visual elements in a video. It includes text 

description of the visual information. Transcripts can be provided as a separate 

document. By providing the transcript as a separate document, individuals with visual 

impairments can easily read and navigate the text-based content using screen readers. 

https://www.w3.org/TR/WCAG20-TECHS/pdf
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5. Mathematical equations 

Mathtype is an equation editor that allows us to create accessible math formulas and is available on 

a variety of platforms.  

1. Use the following link to directly download Mathtype on the preferred platform or 

browse wiris.com to download it. 

2. Depending on the platform the equation editor might differ. In this case we 

demonstrate the windows desktop editor that is installed in Microsoft office. 

3. A mathtype tab is added Microsoft Word’s ribbon. 

4. Upon pressing the following commands are presented. 

 

Figure 59 

5. A short description is shown when the mouse hovers on the commands. 

6. The commands are grouped in categories, add your first equation by pressing the 

Inline command. The editor opens in a new window. 

https://store.wiris.com/en/products/mathtype/download/
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Figure 60 

7. On the top ribbons of the editor all the mathematical expressions are located in the 

different tabs. 

8. With a combination of the keyboard and the symbols you can create the equation that 

you need. 
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Figure 61 

9. Press Ctl+S or Update Document command in order to insert the equation. 

 

Figure 62 
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10. The equation is shown as follows 
2 4

2

b b ac
x

a

  
  

11. If needed, export the document into a web page by saving the file as html or by 

pressing Publish to Mathpage command on the ribbon. 

5.1. Mathplayer 

Mathplayer provides the means for assistive technology such as screen readers and screen 

magnifiers to speak, navigate, and convert to Braille math in the different type of documents or on 

the web. MathPlayer 4 speaks, navigates, and Brailles math with NV Access' NonVisual Desktop 

(NVDA) in Microsoft Word & PowerPoint. Many of the most popular Windows screen readers, such 

as NVDA, Window-Eyes, JAWS, HAL, Supernova, Serotek System Access, MAGic, Read & Write and 

BrowseAloud, will work with MathPlayer to speak the math in web pages along with the words. 

1. Use the following link to download Mathplayer 

2. Mathplayer with word and powerpoint 

Math player can speak, navigate and Braille mathematical equations in conjunction with NVDA. After 

installation a tab is added at the ribbons of word and powerpoint. 

 

Figure 63 

 

6. Chemical equations 

Chemtype is a personalized toolbar with specialized chemistry buttons to edit your inorganic 

chemistry formulas.  

https://docs.wiris.com/en/mathplayer/start#:~:text=%20a%20free%20download%20from%20our%20website
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1. Use the following link to download Chemtype. It can be installed as an add-on in the 

google workspace (docs, slides). 

2. The editor differs from the mathtype editor. 

 

Figure 64 

3. Using a combination of keyboard and commands create the preferred equations. 

7. Verbal descriptions 

Verbal descriptions are a simple and economical way to provide access to visual information, 

such as pictures/graphics, to individuals with visual impairment. Verbal descriptions help individuals 

with visual impairment form their own mental images for the described picture and, thus, allow them 

to participate in information sharing, education and entertainment equally to sighted individuals. 

Despite the advantage of not demanding much time, money and equipment, the effectiveness of a 

verbal description increases when it accompanies a tactile graphic. 

Even though there are no standard official rules for verbal descriptions, we must take into 

consideration that our goal is to describe the picture fully to the individual with visual impairment in 

order for them to obtain the included information to the same degree as a sighted individual would 

by looking at it, but we should not exhaust the individual with visual impairment with extensive 

descriptions of information of little value the image may contain. It is essential that a verbal 

description provides enough information to the individual on one hand, but does not bombard them 

with it as it could make comprehension more difficult. A great deal of information cannot be 

adequately stored in memory in order to be combined for the formation of a mental image. 

https://demo.wiris.com/mathtype/en/chemtype.php
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Some instructions we should follow when creating verbal descriptions are: 

 Start from the general and go towards the specific. A verbal description must begin 

with general information describing the picture as a whole and continue with more 

specific information regarding its content. 

 Mention firstly the main subject of the picture and its context.  When introducing a 

verbal description, we should mention the main subject of the picture and the 

context it relates to. For instance, the subject of an picture may be a statue called 

“The Laocoön Group”, which relates to the wider subject of Hellenistic art. 

 If essential, describe general features such as the size or shape. Describing these 

may be essential when a picture has the same shape as the object it depicts, for 

example the shape of a planet, or when the size is such as to emphasize the size of 

the real object, for instance to emphasize the size of a mural. 

 Mention the focal points of an image. Before mentioning the details of a picture, we 

have to mention its focal points. For example, to describe Vermeer’s painting “Girl 

with a pearl earring”, we would mention first that the painting shows a girl looking 

over her shoulder. 

 Mention the positions of the objects when describing them. After briefly describing 

the focal points of a picture, we should mention them again and give more 

information and the position of each in a logical order, for example from the left to 

the right in order to boost the ability of the reader to create a mental image of the 

picture. In the description, we also usually mention the relative positions of the 

objects in relation to two axes (the horizontal and the vertical), if we think it will help 

readers understand better. For example, the car is on the left of the tree and above 

it. 

 Omit any information that is irrelevant in relation to the context. A verbal 

description may not include some aspects of the picture when these are essentially 

decorative and do not have any relation to the context of the picture, such as the 

text an image may accompany. 

 Ensure that the vocabulary used does not include concepts which are more familiar 

to sighted individuals. Concepts like brightness or shadows are difficult to 

understand for individuals with visual impairment so we must employ alternative 

ways to describe them. 

 Use analogies and / or comparisons between objects. We can use analogies in a 

verbal description by employing concrete (not abstract), concepts which are familiar 

to sighted individuals as well as to individuals with visual impairment. For instance, 

we could say that, if we had to estimate the height of the boy shown in a picture, he 

would reach the knee of a grown man or that a giant has the height of five grown 

men. Regarding the comparisons between the sizes of the objects shown in a picture, 

in an illustration of “Alice in Wonderland”, we could say that Alice has approximately 

the same height as the mushroom the caterpillar is sitting on. 

 If necessary, describe the feelings a picture provokes. We can include the feelings 

an image provokes in a verbal description, when necessary, as long as we take into 
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account the creator’s intentions and not our own personal feelings for the picture. 

For instance, a creator may have intended to highlight the brutality of war through 

his work. 

Some advantages and disadvantages of verbal descriptions in comparison to other methods 

of presenting / creating pictures (tactile pictures, audio-tactile pictures) for individuals with visual 

impairments are presented below: 

Advantages: a) low cost, b) easy to produce, as special equipment / software is not needed, c) 

effective in various occasions, d) does not require expertise on specific software / devices. 

8. Tactile graphics 

The form of a tactile image is derived from the corresponding visual image, by presenting its basic 

features in the appropriate tactile form. They are not mere transcriptions of images; information 

needs to be correctly conveyed from visual to tactile form and designed in a manner that is the most 

meaningful to the reader. 

8.1.1. Key actions of and decisions of the planning process  

In the beginning, educators have to decide if the corresponding image is appropriate for tactile 

graphic. The following questions have to be answered: 

 What is the type and purpose of the image? 

 Does it provide essential information? 

 Does it have description and is it adequate? 

 What is the connection between the image and its description, how does the image 

complement the description. 

 Is tactile representation more useful? 

Then proceed and create tactile graphics when the image: 

 Represents spatial or other information that cannot be described 

 Otherwise, inaccessible 

Afterwards, the following actions are in place. 

Identification of the content that needs to be included 

 Determine the scale of the graphic. 

 Is it necessary to maintain size relationship between objects? 
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Generalization and simplification of the image 

 Discard unnecessary parts 

 Separate the graphics with too many components into sections 

 Replace the objects or shapes that are present, if possible, with simpler symbols 

 Information coding (keys/legends) 

Identify the included components and determine the haptic symbols that will be used 

 Areas, Lines, Points, Labels 

Tactile graphics can be created by both mechanical methods, as well as with simple handcrafted 

methods with the usage of simple everyday materials such as wood, fabric, glass, metal, plastic, 

paper, etc. 

A feature that plays major role in tactile graphics is the texture of the elements. Different parts of an 

image can be presented by using different textures and techniques. The reader with visual 

impairment distinguishes the changes in texture, connects the stimuli and forms the overall mental 

picture of the object being depicted.  

Adjacent textures must be significantly different from each other to be discriminated. The strength of 

the texture helps the reader to prioritize information. The most important information is shown with 

the most important (strongest) textures. White space (also called a dead zone) between areas, 

around labels within textures enhances contrast between textures. 
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Figure 65: Various textures, which can be used in tactile graphics (Eriksson & Strucel, 1995). 

 

Various objects are represented by different symbols that are then decoded by the individuals with 

visual impairment. Differences in shape variable as well as size and rise variables are easily 

discriminated by haptic readers. Thus, two haptic symbols which differ in one of those variables are 

easily distinguished by the user as different without confusion. 

However, to ease the discrimination of haptic symbols, it is necessary to differ more than one haptic 

variable.  

For example, it is easier to distinguish two symbols with different size and shape than two symbols 

which differ only to the shape, especially if the symbols are small. 
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Figure 66: The tactile variables: shape, size, texture, value, orientation and elevation (Papadopoulos & Karanikolas, 2009). 

 

8.1.2. Illustration of tactile graphics using graphics software such as Adobe 

illustrator, CorelDraw, Inkscape 

In this guide we will use the free software Inkscape 
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Use the following link to directly download Inkscape or browse inkscape.org to download it. Install 

the program following the instructions. 

 

Figure 67: Downloading inkscape from website inkscape.org 

Create New document. On the file tab, on the top left, click document properties to select the page 

size and other properties of the graphic you want to create. 

https://inkscape.org/
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Figure 68: Use the properties to determine the page size (image from inkscape software interface) 

On the top of the paper there are several tabs that allow you to edit the whole page or any object 

you design. 
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Figure 69: Tabs that allow you to edit the whole page or any object (image from inkscape software interface) 

On the left there are the drawing tools you will need to create each object, rectangles, squares, 

circles, triangles, lines, texts etc. 
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Figure 70: Drawing tools (image from inkscape software interface) 

On the bottom there are extra tools, such as color selection, Fill and stroke selection. 

On the right there is the auxiliary table with detailed extra properties. 

If you create your first object you will notice small white dots (nodes) on different parts of the object. 

Press the select and transform objects command on the left to edit the objects using these nodes. 
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Figure 71: Ability to transform an object through nodes (image from inkscape software interface) 

On most drawing programs there is the concept of layers. You can draw objects in different layers in 

order to group them and use each group when you need it. On the right auxiliary table can edit the 

layers. 
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Figure 72: Different objects in different layers (image from inkscape software interface) 

Ready-made images can be downloaded online but often they need to be edited in order be 

acceptable as tactile graphics. 

It is better to import an image (such as a jpeg or bitmap) directly into the graphics program and trace 

(use the image as stencil) rather than drawing with the freehand graphics tools. This ensures that the 

scale is maintained and that a more accurate rendition of the print image is achieved. This method 

also allows the designer to make minor changes to the tactile graphic, such as smoothing out any 

jagged coastlines on a map. 

The image will be computer-generated and completed using illustration software.  

8.1.3. Methods of printing/embossing the tactile graphics 

Tactile graphic production method - microcapsule paper 

Microcapsule, puff or fuser paper is a heat sensitive paper and contains chemical ingredients that 

swell up to form a raised texture.  
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Firstly, the image is photocopied on microcapsule paper using a photocopier. Then the microcapsule 

paper is heated using a special device i.e., Piaf tactile image maker. 

 

Figure 73: Piaf tactile maker 

When the printed microcapsule paper is heated the black ink absorbs heat and the capsules on the 

surface of the paper expand providing the raised graphics. 
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Figure 74: Procedure of creating microcapsule tactile material 

Tactile graphic production method Tiger pro embosser 

The embosser has the ability to emboss dots of various heights and much smaller than standard 

Braille embosser. The graphic is then printed directly on plain paper, preferably 160g. 

The digitized graphics can be embossed automatically on tiger or by using its native illustration and 

design program i.e., Tiger designer. 

Tiger Designer is a stand-alone program under Windows to edit emboss data before output on paper. 

It is similar to mainstream paint program. Braille labels and tactile fill patterns can be created. The 

exported File format are PRN or TDSX. 
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PRN file format is specific to each embosser model. Tiger Designer can convert PRN to TDSX format, 

which is generic to all ViewPlus embosser models. 

Differences between microcapsule and tiger tactile graphics 

Microcapsule paper and Piaf tactile maker Tiger pro embosser 

Vector graphics Raster graphics 

The capsules on the surface of the paper 

expand 

The paper is punctured 

Microcapsule paper cost relatively high Plain paper (160g/m is preferred) 

 

 

Figure 75: Difference between the two different methods 

9. Audio-tactile graphics using the Viewplus IVEO Hands-On 

Learning System 

9.1.1. Introduction 

The Viewplus IVEO Hands-On Learning System is a touch sensitive pad (PC peripheral) that can 

simultaneously provide users with tactile and audio information, while they explore tactile graphics 

by their fingers. Tactile graphics include raised graphic patterns that are recognizable only by touch. 

With the use of the touch pad and tactile graphics placed on the touch sensitive pad, information can 

be represented by audio, tactile symbols, audio- tactile symbols (combined) and Braille labels. 
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Figure 76 

9.1.2. Installing IVEO 

STEP 1:  

Open the setup.exe file, located on the installation folder. The IVEO installation screen will appear. 
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Figure 77 

STEP 2:  

Read the license agreement and select the “I accept license terms” check box if you accept the 

following conditions. Then, choose Start Installation and installation will begin. 

 

 

Figure 78 

STEP 3:  
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The Microsoft Text-to-Speech Engine agreement dialog box will appear. Choose Yes to accept. 

 

Figure 79 

Once you accept this agreement, the files will begin copying to your computer. 

 

Figure 80 

STEP 4:  

IVEO has now been installed and is ready for use. Choose OK to exit the screen. 



 

InSIDE project Page  WP2: Adapted Educational Material 

2018-3218 /001-001 [70|85] DEV2.4 Guide on educational material in fully accessible 
form 

 

 

Figure 81 

9.1.3. Getting started with IVEO Creator 

Open IVEO Creator 

Go to Start, All Programs, locate your Viewplus folder and select IVEO Creator. 

 

Figure 82 

Software interface 

Go to Show menu and select Accessible User Interface or Shift + A, in order to uncheck this menu 

item and switch to Standard User Interface. 
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Figure 83 

Once again, go to Show menu and select Toolbar, in order to reveal the toolbar with the basic 

functions of the software. Standard User Interface with Toolbar is now loaded and you may proceed 

with the initial settings of the software. 

 

Figure 84 
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Initial settings 

SETTING 1: 

Go to File menu and select Preferences or Alt + F + E. The Preferences Settings Dialog box allows you 

to adjust current document and screen settings. 

 

Figure 85 

Go to Units of Measurement and choose cm: This option allows you to change the unit of 

measurement within your document so that document size and printer settings are familiar. 

 

SETTING 2: 

Once again, go to File menu and select Scan and Import Preferences. The OCR Settings Dialog box 

allows you to check and make sure OCR Settings are correct, before you import a JPG file. 
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Figure 86 

Go to Language and choose Digits. 

SETTING 3: 

Finally, go to Speech menu and select Speech Settings or Ctrl + Shift + S, in order to change the 

voice, speed and pitch. Select the appropriate voice, speed and pitch and use the test button to 

sample the voice before use. 

 

Figure 87 

If needed, you can install extra voices on your PC, and by the time you restart IVEO Creator, the new 

voices will be added on the Speech Voice menu list. 

9.1.4. Creating a new SVG file 

Using IVEO Creator software, we can create new SVG files. On those SVG files, we can easily assign 

audio information (short message, wav file, link from YouTube, etc.) to specific positions of tactile 

graphics (images, maps, diagrams, etc.), which are intended for use on the touch pad of the IVEO 

Hands-On Learning System. 

 

STEP 1:  
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Go to File menu and select New. 

Define the dimensions of the frame for which the IVEO touch pad will be calibrated. 

The optimal dimensions you can use are: 

33.2 (cm) x 26.2 (cm). 

The optimal margins you can use are: 

Up: 1.8 cm 

Left: 1 cm 

Right: 1.5 cm 

Down: 0.5 cm 

STEP 2:  

Go to File menu and select Import (This option is active for Creator Pro only). 

Select the digital image (*.JPG). The image should, also, have the dimensions of the frame for which 

the IVEO touch pad will be calibrated. 

STEP 3:  

Go to File menu and select Save As. Save the SVG file with a specific name.  

For each new change, go to File menu and select Save. 

9.1.5. Adding shapes on a SVG file 

The concept of adding shapes on a SVG file, is to create a shape (oval, rectangle, polygon) for each 

audio information that we want to assign to the corresponding tactile one. Shapes, which 

subsequently be edited with audio information, are added on top of each tactile information. 

For example, a tactile map (JPG file), 
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Figure 88 

imported to IVEO Creator (SVG file) and added with shapes, will seem like the below one. 

 

Figure 89 
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Adding basic shapes 

Use the Add menu, or press Alt + A, to add different types of shapes: 

OVAL: 

Select Oval or Ctrl + Shift + V and use your mouse pointer to draw an oval. To start drawing, drag 

down in a diagonal line. 

You can add a CIRCLE, as well, by holding Shift along with the drawing. 

 

Figure 90 

RECTANGLE: 

Select Rectangle or Ctrl + Shift + R and use your mouse pointer to draw a rectangle. To start drawing, 

drag down in a diagonal line. 

You can add a SQUARE, as well, by holding Shift along with the drawing. 

 

Figure 91 

POLYGON: 
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Select Polygon or Ctrl + Shift + P and use your mouse pointer to draw a rectangle. To start drawing, 

use the left mouse click for every single edge of the polygon. 

HINT: Press the SPACE bar when you want to shift modes or shapes. This returns you to Selection 

Mode. 

 

 

Figure 92 

9.1.6. Editing elements on a SVG file 

The concept of editing elements on a SVG file, is to assign audio information (short message, wav 

file, link from YouTube, etc.) to the added shapes (ovals, rectangles, polygons, etc.) and transform 

them, when needed.  

The functions of IVEO Creator which are fundamental for a full production of an audio-tactile SVG file 

are: 

 Selection Mode 

 Element Properties (Assign audio to a shape) 

 Select Color 

 Move Selected Element 

 Scale Selected Element 

 Rotate Selected Element 

 Duplicate Selected Element 

 Delete Selected Element 

 Arrange Elements 

 Document Description (Assign audio to the SVG file) 
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Selection Mode 

The Selection Mode allows you to select objects (shapes, etc.) on the SVG file. 

 

Figure 93 

Element Properties (Assign audio to a shape) 

Having a shape selected (Selection Mode), go to Edit menu and select Element Properties or Alt + 

Enter, in order to assign audio to the shape. 

 

Figure 94 

Title: Type the audio message you want to listen when you select the specific space (rectangle, 

ellipse, polygon, etc.). 

Description: Optionally, type a short description for the specific shape. 

Add Link/Sound: Instead of a sound message, you can assign a sound file (eg *. wav file) which will 

be heard when the specific shape will be selected. 

Select Color 

Having a shape selected (Selection Mode), go to Show menu and choose Select Color or Shift + C. 
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Figure 95 

A dialog box will appear with a variety of different colors to choose from. The Fill option allows you 

to edit the color of the entire shape and the Stroke option allows you to edit the outside border of 

the shape by changing the color and thickness of the line. 

Move Selected Element 

In order to move a shape within the SVG file, select the Move Selected Element feature. Grab your 

shape, by holding down the left mouse button, and then drag the shape and release the mouse when 

desired destination is reached. 

 

Figure 96 

Scale Selected Element 

In order to resize a shape, use the Scale Selected Element feature. Editing points will appear for 

adjusting purposes. To move your element, select the dark blue middle square, drag and drop. To 

preserve the same proportions, hold down the Shift key while scaling. 
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Figure 97 

Rotate Selected Element 

Select the Rotate Selected Elements icon, and then select your shape. Editing points will appear. Use 

your left mouse button to click and drag the shape in a specific direction. Release when finished. 

 

Figure 98 

 

Duplicate Selected Element 

Having a shape selected (Selection Mode), go to Edit menu and select Duplicate Selected Element or 

Ctrl + Alt + D. 

Move the copy of the element to the desired position (Move Selected Element). 

Delete Selected Element 

Having a shape selected (Selection Mode), go to Edit menu and select Delete Selected Element or 

Ctrl + Shift + Delete. 



 

InSIDE project Page  WP2: Adapted Educational Material 

2018-3218 /001-001 [81|85] DEV2.4 Guide on educational material in fully accessible 
form 

 

Arrange Elements 

Having a shape selected (Selection Mode), go to Edit menu and select Arrange in order to arrange the 

shapes that overlap. There are 4 choices: 

Move Forward: Move forward one level. 

Move to Front: Move to foreground. 

Move Backward: Move backward one level. 

Move to Back: Move to background. 

Document Description (Assign audio to the SVG file) 

Go to Edit menu and select Document Description. 

Title: Type the sound message that you want to listen when you open the SVG file. 

Description: Optionally, enter a short description for the SVG file. 

9.1.7. Calibration of the IVEO touch pad 

STEP 1:  

Go to Touchpad menu and select Calibrate from current image. 



 

InSIDE project Page  WP2: Adapted Educational Material 

2018-3218 /001-001 [82|85] DEV2.4 Guide on educational material in fully accessible 
form 

 

 

Figure 99 

STEP 2:  

As long as the communication window appears and the initial instructions for the calibration are 

given (Touch left top corner of the image / Press SPACE to confirm), touch the top left corner of the 

tactile graphic with a pin (e.g. pencil tip, pen cap, etc.) and press the space key (SPACE). 

STEP 3: 

As long as the communication window continues to appear and the following instructions for the 

calibration are given (Touch bottom right corner of the image / Press SPACE to confirm), touch the 

lower right corner of the tactile graphic with a pin (e.g. pencil tip, pen cap, etc.) and press the space 

key (SPACE). 

STEP 4: 

Calibration is complete. IVEO Hands-On Learning System is ready for use. 

9.1.8. Getting started with IVEO Viewer 

Open IVEO Viewer 

Go to Start, All Programs, locate your Viewplus folder and select IVEO Viewer. 
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Figure 100 

Initial settings 

SETTING 1: 

Go to Speech menu and select Speech Settings or Ctrl + Shift + S, in order to change the voice, speed 

and pitch. Select the appropriate voice, speed and pitch and use the test button to sample the voice 

before use. 

 

Figure 101 

If needed, you can install extra voices on your PC, and by the time you restart IVEO Viewer, the new 

voices will be added on the Speech Voice menu list. 

SETTING 2: 

Go to File menu and select Preferences. The Preferences Settings Dialog box allows you to set 

options before a document is viewed. 
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Figure 102 

9.1.9. Exploring an audio-tactile graphic 

STEP 1:  

Place the tactile graphic on the surface of the IVEO touch pad. 

STEP 2:  

Open IVEO Viewer software. Go to File menu and select Open. 

STEP 3:  

Select the relevant audio-tactile SVG file you have created. 

STEP 4:  

Go to Touchpad menu and select Calibrate From Current Image. 

STEP 5:  

Follow the calibration procedure, described in detail through the “Calibration of the IVEO touch 

pad” instructions. 
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STEP 6:  

Explore the audio-tactile graphic using the IVEO touch pad. 

 

Figure 103 


